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Instructor Contact Information

◼Email

◼dbrandon@cbu.edu

◼Phone

◼321-3615 (email is better)

◼Office

◼BU 302
◼ Check office door for current physical office hours

◼ Some office hours are online, online courses may 

have all office hours online
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Canvas

◼ Canvas is now used for this course

◼ Whether this class is in-person, online, or 

hybrid:

◼ All submissions of assignments are to be 

submitted via Canvas

◼ Gradebook is in Canvas

◼ Canvas contains the syllabus page and the 

course policies page
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Canvas (con’t)
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Canvas (con’t)
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Syllabus in Canvas
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Lesson Files & Multimedia

◼ Some slides contain video links/lessons (see image 

below) - make sure your sound is fully enabled

◼ Videos contain additional information or information 

presented in another manner, and the videos are 

generally prepared by industry experts in the field

◼ For some videos, you may have to hit the browser back 

or exit button to return to this lesson

◼ Some videos may require you to enter your session 

content username/password (supplied to students in 

class)

◼ Some videos may have expired or been removed

◼ Let instructor know if your encounter this
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https://www.youtube.com/watch?v=iOrP24OYm_g


Textbook

◼HTML 5 and CSS

◼Patrick Carey

◼Latest edition

◼Cengage
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CBU Follet Access Program
[https://www.cbu.edu/bookstore/follett-access-book-program/]

◼ Now all CBU class textbook rental and required supplies 
costs will now be included in a flat-rate "book fee" on your 
CBU bill so that you know in advance what your costs will 
be

◼ The Follett ACCESS Program delivers required materials 
for the courses for which you’re registered, making sure 
you’re prepared for the first day of class

◼ Students will be charged $23 per credit hour (Spring 2022 
rate) to cover all required course materials

◼ To make paying for the fee convenient, it can be included in 
any payment plan you choose

◼ Typically, students save money with the flat fee based on 
total credit hours!

https://www.cbu.edu/bookstore/follett-access-book-program
https://nam11.safelinks.protection.outlook.com/?url=https%3A%2F%2Fcbu.us11.list-manage.com%2Ftrack%2Fclick%3Fu%3D1f1ab5bdb74014543243327d2%26id%3D9aabce2b33%26e%3D52b1990ec3&data=04%7C01%7Cdbrandon%40cbu.edu%7C29dcc88d991a460264b208d9b3568a88%7C8e01b9487f904068a737735638e01794%7C0%7C1%7C637738006576043835%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000&sdata=THHURAtvHlK%2BsRyvkkECLNxrvnK5YMFXEmu3VMsSMUM%3D&reserved=0


CBU Follet Access Program
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Cengage Unlimited
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Cengage Unlimited (con’t)
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Cengage Unlimited (con’t)

◼ All that is required of the student for a Cengage Unlimited 

subscription is to come by the CBU bookstore and choose whether 

they would like a 4 month (119.99), a 12 month (179.99), or 24 

month access (239.99)

◼ With this access, they will have every book Cengage has ever 

digitized, which is around 22,000 total titles and about 7800 that 

Follett currently uses across all US stores

◼ Even if they are not taking the course the book is being used for, 

they can still access that title

◼ All instructors need to do is adopt the book through the bookstore 

and on the Shelf Tag, it will print the prices for the New and Used 

Retail, New and Used Rental (If Applicable) the three tiers of 

Cengage Unlimited, and the eBook only price
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Cengage Unlimited eTextbooks
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Grading

◼20 % - Project 1 

◼20 % - Project 2 

◼20 % - Project 3

◼40 % - Homework 
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Backups

◼Students are 

responsible for 

backing up their files

◼ Losing a file (or an 

USB) is no excuse

◼Office 365 OneDrive

◼Cloud Providers
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Cloud Backup & Sharing Sites



Question

◼Why web 

based

software ?

Don’t look ahead !



Web Based Software (con’t)

◼Universal “platform”

◼Uniform interface (the browser) and 
ease of usage and training

◼Utilizes the  Internet (speed, 
security, cost)

◼Less configuration control issues 
(on the user/PC end)

◼Overall economics



IT Jobs Most in Demand
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Hot IT Jobs



Mobile & Web Aps



Basic HTML



HTML
◼ Hypertext Markup Language

◼ Most commonly used of several Internet 

Markup Languages

◼ HTML is effected by “marking up” a document 

(“tags”), similar to the way you would mark up 

a memo for a secretary to type it in a polished 

form

◼ Some Browsers are capable of interpreting 

proprietary tags, and the language continues 

to evolve (new tags are being added)



History of HTML
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HTML Versions

◼ “Old” HTML
◼ Versions < 4

◼ Static

◼ Tags define:
◼ Layout: <table> <ul>

◼ Appearance: <hi> <i.

◼ Combining tags for 
specific appearance:
◼ <b><i>…</i></b>

◼ “New” HTML
◼ Versions > 4

◼ Dynamic (DHTML)

◼ Page element 
identification (DOM)

◼ Tags define content

◼ Style (css) determine 
appearance

◼ Full support for 
scripting (JavaScript)



Looking at HTML in Documents

◼Open HTML Document

◼View Menu

◼Source

◼Let at an example web page



CBU Web Site



CBU Web Site – View Source
[some browsers will open Notepad, and others will show the 

source code in another viewer]



Building HTML Documents

◼ Text editor (i.e. Notepad)  used in this class

◼ Other HTML editors such as Notepad++, 

Eclipse, CoffeeCup, and Microsoft Visual 

Studio include syntax checking to weed out 

errors and automatic insertion of HTML code

◼ Word Processor (text mode only)

◼ HTML editor built into some browsers

◼ HTML “converters” built into some products (ie

M/S word, etc.)



Notepad ++



Building HTML Documents (con’t)

◼ IDE (Integrated Development Environment)

◼ WYSIWYG – drag & drop

◼ Software providing comprehensive coverage of 

many phases of the development process from 

writing HTML code to creating scripts

◼ Popular IDEs: Adobe Dreamweaver, 

FrontPage/Sharepoint, Aptana Studio, NetBeans 

IDE, and Komodo IDE

◼ Business templates

◼ Wix

◼ Google Sites

Copyright Dan Brandon, PhD, PMP
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Building HTML Documents (con’t)

◼ A web content management system (wcms) 

provides authoring tools for website content 

and administration using prepackaged 

templates

◼ Websites usually involve the integration of 

many technologies and languages

◼ Managing all those technologies is the job of 

a web framework that provides the foundation 

of the design and deployment of web 

applications

Copyright Dan Brandon, PhD, PMP
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Our Procedure to Build HTML Document

◼Use a Windows editor (ie “Notepad”)

◼On Mac’s, use TextEdit

◼On Ubunto, use gedit

◼Save file as text file with “.htm” or “html” 
extension; use quotes around 
filename(“myPage.html”)

◼ “Open File” in Browser to look at your 
work (or double click on file con)

◼Keep both editor & browser windows 
open as you refine your home page



Saving an HTML file Locally
[note: file type, name.extension, and quotes]

When viewing a folder, make sure the option to turn off file extensions is not activated!



Tools -> Folder Options - > View

Remove check mark from hide extensions, then “apply”



Windows 10+



Editor on MACs

◼ TextEdit is the default text editor on Macs, and it comes pre-installed with 
macOS. You will find it in the Applications folder and the app allows you to 
write either in RTF (rich text format) or plain text (txt). For creating HTML 
files, you want to save the file as a plain text file, but with the .html file 
extension not the .txt file extension.

1. In the TextEdit app on your Mac, choose File > New, then choose Format > 
Make Plain Text.

2. Enter the HTML code.

3. Choose File > Save, type a name followed by the extension . html (for 
example, enter index. html), then click Save.

4. When prompted about the extension to use, click “Use . html.”

◼ Video lesson: https://www.youtube.com/watch?v=ZsR_QSoGJLY

https://www.youtube.com/watch?v=ZsR_QSoGJLY


HTML5 Tutorial
[http://www.w3schools.com/html5/default.asp]

http://www.w3schools.com/html5/default.asp


Basic HTML - Video Tutorial

Note that this tutorial will have you save your

Notepad/Wordpad files as “html” files, and in our

tutorial we have you save the files as text files using the

“html” or “htm” file extension.

http://www.youtube.com/watch?v=RRvJ9ff0TUs


HTML Documents

◼HTML documents consists of two 
parts

◼Head - heading information 
(prologue)

◼Body - body of document

◼Both the head and the body use 
pieces of code called tags



Tags

◼ Tags style text, link files, embed graphics, insert 
tables, etc.

◼ Tags can be typed as all capitals for clarification, 
although they are not case sensitive; current 
recommendation is lowercase

◼ Syntax is:
◼ <Tag_Name Property_List>...content...</Tag_name>

◼ The property (or attribute or argument) list is 
optional

◼ Example:

◼ <h1 id=“main_title”>Garage Sale</h1>



Tag Pairing

◼ Some tags can be used by themselves, like 

<p> (tag to end a paragraph) - Best to use in 

pairs for new HTML 4+ capabilities such as 

<p> to start a paragraph and </p> to end a 

paragraph

◼ Other tags must be used together, like <h1> 

and </h1> which styles a first level (1) 

heading; the two tags surround the heading

and the second tag has a slash



Elements

◼ An element is combination of a starting tag, 

content, ending tag, and attributes

◼ It is fundamental building block in every 

HTML document

◼ Starting tag (<element>) indicates the 

beginning of an element

◼ Ending tag (</element>) indicates the 

ending of an element

◼ Two-sided element tag general syntax

<element>content</element>

Copyright Dan Brandon, PhD, PMP
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Empty Elements

◼ Empty elements are elements that are either 

nontextual (images) or contain directives to the 

browser about how the page should be treated

◼ An empty element is entered using a form of the 

one-sided element tag:

<element /> or <element>

◼ For example, <br /> is used to indicate the 

presence of a line break in the text

◼ The ending slash /> form is required only in 

XHTML documents as well as some other markup 

language
Copyright Dan Brandon, PhD, PMP
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Element Attributes

◼ Element attributes provide additional 

information to the browser about the purpose 

of the element

◼ The general syntax of an element attribute is

<element attr1=”value1” 

attr2=”value2” ...> 

content</element>

where attr1, attr2, etc. are the names of 

attributes associated with the element and 

value1, value2, etc., are the attribute values

Copyright Dan Brandon, PhD, PMP

56



Element Attributes (con’t)

◼ For attributes that do not require a value, 

HTML supports attribute minimization by 

removing the attribute value completely

<p hidden>Placeholder Text</p>

◼ The hidden attribute does not require a value; 

its mere presence indicates that the marked 

paragraph should be hidden in the rendered 

page

Copyright Dan Brandon, PhD, PMP
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<HTML> and </HTML>

◼Each document 

should start with 

the <HTML> tag 

and end with 

</HTML>

◼ <!DOCTYPE html>

◼ <html>

◼ ...document text & 

tags...

◼ </html>



<HEAD> and </HEAD>

◼ The <HEAD> 
tag should be 
at the top of 
your 
document, and 
denotes the 
start of your 
heading area

◼ The </HEAD> 
denotes the 
end of your 
heading

◼ <html>

◼ <head>

◼ <meta charset=“utf-8”>

◼ ...heading...

◼ </head>

◼ ...document text & tags...

◼ </html>



Elements in the HEAD

Copyright Dan Brandon, PhD, PMP
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<TITLE> and </TITLE>

◼ <TITLE> and 

</TITLE> denote 

the start and end 

of the text that will 

show in the title 

bar of the browser 

window when your 

document is 

loaded

◼ <html>

◼ <head>

◼ <meta charset=“utf-8”>

◼ <title>

▪ John Doe’s Home Page

◼ </title>

◼ </head>

◼ . ..document text & tags...

◼ </html>



<BODY> and </BODY>

◼ The main 

part of 

your 

document 

is 

delimited 

by the two 

body tags

◼ <html>

◼ <head>

◼ <meta charset=“utf-8”>

◼ <title>

▪ John Doe’s Home Page

◼ </title>

◼ </head>

◼ <body>
◼ ...document text & tags...

◼ </body>

◼ </html>



HTML Structure

Copyright Dan Brandon, PhD, PMP
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Indentation

◼ The use of indentation (via tab key) for nested HTML 

tags will improve readability of source document

◼ Browsers only use HTML tags for rendering content; 

tabs and returns are ignored

◼ <HTML>

◼ <HEAD>
◼ <TITLE>

▪ …

◼ </TITLE>

◼ </HEAD>

◼ <BODY>
◼ <P>

▪ …

◼ </P>

◼ </BODY>

◼ </HTML>



HTML Structure (con’t)
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<Hi> and </Hi>

◼ These tags 

surround text 

(usually 

headings) and 

indicate level (i)

◼ The level will 

determine the 

relative size of 

the text when the 

browser displays 

it (1 thru 6)

◼ <html>

◼ <head>

◼ <meta charset=“utf-8”>

◼ <title>

▪ John Doe’s Home Page

◼ </title>

◼ </head>

◼ <body>

◼ <h1>John Doe</h1>

◼ . ..rest of document text & 

tags...

◼ </body>

◼ </html>



<P>

◼ This tag indicates 
the start/end of a 
paragraph

◼ The browser will 
typically place a 
blank line at this 
point

◼ You can also use 
this tag in pairs 
(<P> & </P>) to 
delimit 
paragraphs

◼ <html>

◼ <head>

◼ <meta charset=“utf-8”>

◼ <title>

▪ John Doe’s Home Page

◼ </title>

◼ </head>

◼ <body>

◼ <h1>John Doe</h1>

◼ <p>Some info…

◼ </body>

◼ </html>



Organizing Tags

◼Some tags are just used to organize 
information:

◼ <div>…some stuff…</div>

◼ <span>…some stuff…</span>

◼DIV will typically go to new line

◼Needed for Dynamic HTML to give a 
name or id to each bit of stuff that will 
be changed dynamically

◼HTML% has newer more meaningful 
organizing tags



Images  [lab - htmllab1.htm]

◼ Images use the 

<IMG> tag 

which requires 

additional 

information 

called 

arguments such 

as the 

filename/path 

and an 

alignment

◼ <body>

◼ <h1>John Doe</h1>

◼ <img align=“left” src=“john.gif”>

◼ <p>

◼ ...body of document...

◼ </body>



Warning…

◼Be very careful using any cut-

and-paste from PowerPoint into 

Wordpad or Notepad !!!

◼Some symbols (such as quotes) 

are not the same in PowerPoint 

and other Microsoft applications



Lab1

◼ Create an initial home 
page document with:

◼ heading & body

◼ title

◼ your name (h1)

◼ your photo
◼ source file argument is 

“src” not “scr”

◼ some text

◼ For now, you can use 
any image you get off 
the web until you obtain 
photo image – but for 
the homework at the end 
of this lesson you need 
your photo image



Copying Images in In WWW Documents

◼Place mouse on image

◼Right Click

◼Pick “save image” 

◼Cannot do this for images displayed 

from within Java applets or otherwise 

protected

◼Download from image sites such as 

Google image



Making Your Own Images

◼Draw then

◼ Paintbrush (.BMP files), or other drawing 
programs 

◼Scanning

◼ University & Department resources

◼Digital Cameras & Cell Phones

◼Mail in Photography (get back diskette)

◼Video Capture & “frame grabber”



Image Processing

◼ Images come in a variety of file formats

◼ Different browsers can handle different 

formats (gif, jpeg, pcx, etc.), all browsers can 

handle:

◼ “.gif” (Graphics Interchange Format) 

◼ “.jpeg” (Joint Photographic Experts Group) 

◼ “.png” [“Portable Network Graphic”] 

◼ Try to convert all your images to these  

formats



Graphic File Formats
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Graphic File Formats (con’t)

◼ JPEG compression should be used for 
continuous tone images such as most 
photographs

◼ JPEG is “lossy” compression which means that it 
may alter your image slightly for maximum 
compression

◼ GIF/PNG  should be used for drawings, screen 
captures, animation, and the like -- also if you 
want a transparent background

◼ Animated Gif’s - Gif file consists of several 
images, which are shown in a time staggered 
manner



Search and Make Animated Gif’s



Graphics Software Color Reduction
[can reduce file size while not visually altering image much]

Color reduced - 50 colorsOriginal 256 colors

100,000 bytes 40,000 bytes



Image Processing Software

◼GIMP

◼Paint Shop Pro

◼Microsoft PictureIt

◼Adobe Photoshop, PhotoDelux, etc.

◼Macromedia Dreamweaver/Flash

◼Corel Print House Magic Delux

◼MGI PhotoSuite

◼ LivePix



GNU Image Program
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Photo Editing On-line – Google+



Photo Editing On-line – Picnik.com



Transfer Time for a 100KB File
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Multimedia Download Time

1.5Mbps

Low cost DSL

5Mbps

Standard Cable

50 Mbps

Fiber

1MB MP3 Song 33 sec 10 sec 1 sec

50MB Photo 

Album
5.5 min 1.7 min 10 sec

125 MB Video 

Game
14 min 4 min 25 sec

5 GB HD Movie 9 hours 2.8 hours 17 min



Image Sizes (bytes)
[smaller images with less detail require less file space]

Smile

700

Michael Jordan

36000

Lois Lane

10000



Image Dimensions

◼ The ‘Width’ and ‘Height’ arguments can be used to 
scale images

◼ Browsers will stretch or squeeze the image to fit in 
the space indicated (not retaining proportions)

◼ These arguments also speed loading by telling the 
browsers how big a space (in pixels) to reserve so 
they can add the text immediately instead of waiting 
to see how big the image is going to be:
◼ <img src=“me.gif” width=“100” height=“150”>

◼ However, reducing the display size does not reduce 
the size of the image to be downloaded (use image 
editing software for that task !)



Aligning Graphics with Text

◼ You can align graphics with text using the ALIGN 
attribute within the <IMG> tag

◼ Options are:

◼ top - text aligned with top of image

◼ texttop -

◼ middle - text aligned with middle of image

◼ absmiddle

◼ bottom (or baseline)- text aligned with bottom of 
image

◼ absbottom

◼ Default is bottom

◼ <img align=“top” SRC=“me.gif”>...text...



Adding Space Around Graphics

◼ You can add space around images with the 

‘VSpace’ and ‘HSpace’ arguments

◼ Use ‘VSpace for space on top and bottom

◼ Use ‘HSpace’ for space along the sides

◼ Example:

◼ <img src=“me.gif” align=“left” hspace=“50” 

vspace=“10”>



Centering

◼ The ALIGN property of the IMG tag aligns an 

image relative to neighboring text

◼ To center an object on the page, you can put 

it inside of a table (discussed later), or you 

can use CSS (discussed later):

◼ <p style=“text-align:center”><img 

src=“me.gif”></p>

◼ Older types of centering are deprecated:

◼ <CENTER><IMG SRC=“me.gif”></CENTER>



Image Source File

◼ The SRC image indicates the location of your 
image file

◼ If you do not specify a path, it is assumed 
to be in the same directory as your home 
page – and that is the recommended 
approach in this class

◼ Some images look better with “transparent 
backgrounds” - use a graphic software 
package for conversion

◼ Images are by default horizontally aligned like 
text



Absolute Path

◼ A root folder contains the site’s home page 

the index.html file

◼ An absolute path is a path that starts from 

the root folder and processes down the entire 

folder structure described with the expression

/folder1/folder2/folder3/file

where folder1 is the root folder, 

followed by the subfolders folder2, 

folder3, and so forth, down to the linked 

file
Copyright Dan Brandon, PhD, PMP
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Relative Path

◼A relative path is expressed relative to 

the location of the current document

◼Relative paths are often expressed in 

terms of familial relationships in order to 

indicate the hierarchical nature of the 

folder structure

◼Relative paths go up the hierarchy to 

parent folders by including the symbol 

(..)
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Base Path

◼ A browser resolves relative paths based on 

the location of the current document

◼ You define a different starting point for 
relative paths by adding the following base

element to the document head

<base href="url" />

where url is the location that you want 

the browser to use when resolving 

relative paths in the current document
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Lab 2
◼Align your image

◼Add some text next to your image



Comments

◼To insert comments in your 
HTML code use

◼<!This is a comment>

◼This will allow you (or 
someone else) to better 
understand your HTML code



Line Breaks

◼ <BR> can be used to break a line (start a new line)

◼ Carriage returns, tabs, and line feeds in your editor 
have no effect

◼ Text will automatically flow to the extent of the 
browser window size and will not break otherwise 
unless you tell it to do so

◼ You can use the no break tags (<NoBR> and 
</NoBR>) to keep text from breaking at the end of the 
browser window. If you want text to break within this 
non breaking section, use <WBR> at that point.

◼ To keep text from flowing around a left aligned 
image, use <BR Clear=left>, or for a right aligned 
image: <BR Clear=right> (& <BR Clear=all> for 
between images)



Horizontal Rules

◼ To put a horizontal dividing line in a 
document use <HR>

◼ In HTML5, the <hr> tag displays a horizontal 

rule, and defines a change in the content

◼ One can use Use CSS to style the line



Font Tags - Deprecated

◼ You can change the default fonts size (in points) 
using the <Basefont> tag with the ‘Size’ 
argument:
◼ <Basefont Size=5>

◼ The default size is 3, and the range is from 1 to 7

◼ Using the tag <Font> changes the size for 
regular text but not headings (typically H1 = 6, 
H6 = 1)
◼ <Font Size=7>

◼ You can also change font size in a relative 
manner with + or -.
◼ <Font Size=+1>



Text Styling

◼ Relative tags (phrase elements) are now 

deprecated:
◼ <ADDRESS>  typically used for e-mail and other addresses; shown 

in italics

◼ <CITE> similar to address, normally used for citations

◼ <EM> emphasis

◼ <STRONG> bold

◼ <VAR> indicates a variable (typically italics)

◼ <CODE> or <SAMP> or <KBD> - monospaced text

◼ <BIG>

◼ <SMALL>

◼ <SUB> subscripts

◼ <SUP> superscripts

◼ <TT> Do not use proportional font (ie use a font like Courier)



Text Styles (con’t)

◼ Fixed tags are also deprecated:

◼ Bold <B> and </B>

◼ Italic <I> and </I>

◼ Underscore <U> and </U>

◼ Strikeout <S> and </S>

◼ Blink <Blink> and </Blink>



Text Styles (con’t)

◼Now (HTML5+) one should use 

cascading style sheets (CSS) styling:

◼<div style=“font-size:large”>…</div>

◼<p style=“font-weight:bold”>…</p>

◼<span style=“font-

style:italic”>…</span>

◼CSS discussed more later



CSS Font & Text Wizard
[http://www.somacon.com/p334.php]
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Font Family

◼ As a web page author, you have no control over the fonts 

available on a device

◼ For font-family, you can specify an actual font name, like 

"Courier New" in the custom field

◼ If the name has spaces, you should quote it, and it is 

case-insensitive

◼ You can specify a comma-separated list of font names, 

which will be used in the order listed when some are not 

found on the user's system

◼ Designers should use the most desired font first, the most compatible 

font second-to-last, and the generic font family last and always. For 

example a common font-family value is:

◼ "Verdana", "Arial", sans-serif



CSS Units

◼ When you use specify lengths in CSS, you should generally 

use the relative units appropriate to the property

◼ For width properties, use ex units, which corresponds to the 

width of the lower-case 'x' character

◼ For height properties, use em units, which corresponds to 

the height of the capital 'M' character

◼ Relative units are preferred to absolute units, like px, pt, and 

in

◼ One reason for this is that one day, monitors may have more 

than 96 dots per inch, in which case your 14px font will look 

too small

◼ Other relative values like smaller, bolder, and percentages 

are also better choices than the absolute values



Font Selection



LAB 3

◼ Use the following to 
enhance your home 
page:

◼ Horizontal rules

◼ Breaks

◼ Font and/or text 
style

◼ Include in your 
document: sections 
for your address and 
hobbies

◼ Example →





Another HTML Basic Tutorial

Also HTML “cheatsheet” in textbook appendix B

http://www.youtube.com/watch?v=8S6AeCEe8Fk


HTML Cheatsheet
[http://www.html-5.com/cheat-sheet/index.xhtml]

http://www.html-5.com/cheat-sheet/index.xhtml


Text Level Elements
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Text Level Elements (con’t)
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Grouping Elements
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Sectioning Elements

◼ HTML marks the major topical areas of a page 

using sectioning elements

◼ Sectioning elements are also referred to as 

semantic elements because the tag name 

describes the purpose of the element and the 

type of content it contains

◼ Earlier versions of HTML used primary the 

DIV element, and for compatibility reasons 

you may chose to use just the earlier 

methods
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HTML5 Sectioning Elements
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HTML 5 vs Earlier Sectioning
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HomeworkHomework

Textbook Chapter 1

Complete lab3 & then upload HTML 

file in Canvas
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